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1. Quick reference guide  

A video guide to indexing in Word is available here:  
https://www.youtube.com/watch?v=s8lq84CLYvU

Essential points to remember

•	 The Golden Rule –choose index terms that are likely to be searched for by the 
reader.

•	 Ensure you aren’t indexing material that should not be indexed. See ‘Before 
You Start’ for a full list.

•	 Use spans of text to index an ongoing discussion that continues across several 
pages.  

•	 Each span of text must have a new ‘bookmark’ with a unique name.

•	 Avoid long strings of page numbers in your completed index. We advise 
that you break up main headings with sub-entries if there are more than 6-8 
page numbers under the main heading. We may return the index to you for 
adjustment if this is not done.

•	 Avoid using the ‘mark all’ as much as possible.

•	 Do not use quotes around your index headings (e.g. “Bleak House”) or the 
alphabetisation of the index list will be incorrect.

Basic actions

To index a word or short phrase

1.	 Highlight your chosen word, hold ALT+SHIFT+X.

2.	 Edit the information in the pop-up box as needed.

3.	 Click ‘Add’.

To index a span of text (called a ‘page range’ in Word)

1.	 Highlight the entire span of text that you want to index.

2.	 Go to ‘insert’ in the Word menu and choose ‘bookmark’. Choose a single-word 
name for your span of text and click ‘Add’.

3.	 Place the cursor at the end of your span of text and hold ALT+SHIFT+X to bring 
up the indexing box.
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4.	 Enter your main/sub-entry name, then click ‘Page Range’. Choose the name of 
the bookmark you have just created and click ‘Mark’.

To create your index list

1.	 Place your cursor at the end of the document before any endnotes inserted 
using Word’s automatic endnotes feature.

2.	 Choose ‘Index and Tables’ from the ‘Reference’ submenu of the ‘Insert’ menu 
in Word.

3.	 Press ‘OK’ in the dialogue box that appears.

To edit the index for style after it is completed

1.	 Create the index list as explained above.

2.	 Copy the index list from your indexed manuscript file (just the index list) and 
paste it into a new Word document.

3.	 Turn on ‘Track Changes’ (under the ‘Review’ tab in Word), edit as desired and 
save it with the changes visible to return to Cambridge.
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Indexing in Word or LaTeX before submission means:

•	 Means a simpler, smoother production process

•	 Allows you more time to complete the index and ask for help if needed

•	 Frees up time for answering copyediting queries during production

•	 Allows you to make changes to the text content while indexing

See the specific guides at the end of this document for how to create an index in 
Microsoft Word and LaTeX.

Please note: We are no longer able to accept traditional indexes, i.e. indexes 
generated once a book’s page proofs have been typeset (after copy-editing).

For books written in Word, we now use a process that involves making electronic 
links within the files used for typesetting. This means that:

•	 The electronic version of your book will have an interactive index

•	 The index will adapt if any changes are made to pagination during production

 

2. Why Index Before Submitting your Manuscript? 
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The Golden Rule

An index is a tool for the reader and not a summary of a book’s content, so you 
should always use what is likely to be looked up by the reader as a guide for what 
to include or exclude.

A good index is

•	 Clear and concise

•	 Uncluttered – no extraneous/irrelevant information

•	 General, then specific (e.g. breaking up general headings with more specific 
sub-headings)

•	 User-focused 

Before starting

Review the indexes in books covering similar topics. Consider indexes you have 
used that have or have not helped direct you to the content you were seeking.

A list of useful indexing resources is available at the end of this guide.

Note: There may also be subject-specific requirements – if in doubt, consult your 
Cambridge contact.

Please note that the index and the chapter keywords that we ask you to submit 
with your manuscript are two distinct, unrelated requirements. The index is for 
the back of the book, whereas we use the chapter keywords to improve the digital 
discoverability of your book.

Language style

The language style (e.g. UK, US, Canadian) should match the style used in the main 
text.

 

 

 

3. Before you Start  
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General

Keep the index simple. It is useful to put yourself in the position of your potential 
readers. A book on economics, for instance, might include Mr Micawber’s famous 
quote:

“Annual income twenty pounds, annual expenditure nineteen, nineteen and six, result 
happiness. Annual income twenty pounds, annual expenditure twenty pounds ought 
and six, result misery.”

However, readers would be unlikely to look for ‘Micawber’ in the index.

A good guideline for indexing the average academic book is that the index should 
be around 5% of the pages of the total typeset book, and a little longer – around 
8-10% – for reference works.

What not to include in an index

An index should not contain references to the following sections of a book’s text:

1.	 Front matter – title page, table of contents, dedication, epigraphs, lists of 
illustrations or tables, acknowledgements must not be indexed

2.	 Bibliography

3.	 Chapter titles

4.	 Footnotes and endnotes should not be indexed if they only contain 
bibliographical data and should be indexed only very sparingly otherwise.

These items should be avoided as they tend to be unhelpful for the reader:

•	 Verbs or adjectives standing alone – e.g. peripheral; circular; global.

•	 Author/scholar names should be kept to a minimum (e.g. those authors or the 
works of authors discussed substantively in the text). No names concealed 
under ‘et al’ when referenced in the text should be indexed. If you include 
these, we may return the index to you for adjustment.

•	 Information from notes (unless it is likely to be sought by the reader and is not 
discussed in the main text). 

4. Content  

http://www.cambridge.org/gb/academic/authors/author-hub#fRRc9BkrdgAi3V4W.97
mailto:authorhub%40cambridge.org?subject=


Author Hub | Indexing 8/24

•	 Passing mentions that do not give substantive, pertinent information about the 
topic or person.

•	 Tables or illustrations should be indexed only if they provide information in 
addition to what is contained in the text. Page numbers for illustrations or 
table should be in italic. Where the illustrations are not present in the text 
(for authors writing in Word), you can index the placement instructions or 
captions instead.

•	 Long spans of text or entire chapters indexed as a single entry.  
E.g. Cognition, 6-284  
Spans of text should not be more than around 15-20pages long.  

Avoid using ‘Mark all’ if using the Microsoft Word indexing tool. This can 
cause technical problems with the index and will also index all mentions of a word 
indiscriminately, resulting in an index that is most unhelpful to the reader. If you 
use ‘Mark all’ throughout the index we may return it to you to remove the extraneous 
page references.

What to include in an index

A typical index entry is composed of the main heading (and page numbers), 
subheadings (and page numbers), as well as any cross-references.

 
Main headings

NB: Use nouns or noun phrases, not adjectives. 

For example:

1.	 Terms or concepts used throughout the book.

2.	 Names of authors whose work is quoted or discussed at length.

3.	 Names of people mentioned because of their importance in the text.

4.	 Names of relevant countries, regions, and jurisdictions.

5.	 Names of relevant organisations, political parties, and institutions.

 
 
Subheadings

NB: Sub-entries should be used when the main entry would contain more than six 
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page numbers.

For example:

1.	 Aspects or explanations of terms, concepts, and actions.

2.	 Subdivisions logically related to the main heading.

3.	 Works by authors listed as main headings.

NB: Avoid additional levels of heading. Headings and sub-headings should be 
sufficient to cover the content but without confusing the reader.

 
Cross-references

These fall into two main types and are useful for guiding the reader and keeping 
the index concise.

1.	 “See” references are used to assist the reader in finding a subject or name 
that may appear in the text in more than one form – e.g.  
Carroll, Lewis see Dodgson, Charles L. 
Charles Lutwidge; NATO see North Atlantic Treaty Organisation

2.	 “See also” references are used to direct the reader to topics linked to the 
topic entry e.g. bodies, falling see also motion 
post-communist countries see also countries by name

Spans

Where a topic is discussed for longer than a few words or continues across several 
pages, it is vital to index this as a span of text rather than index multiple small 
instances. Indexing multiple occurrences can lead to a cluttered and confusing 
entry to the index, e.g.:

Joyce, James, 47, 48, 49, 50, 51, 52, 53, 54 

Use the following format instead:

Joyce, James, 47-54

To achieve this, you need to capture the whole span of text as one item (please 
refer to the specific instructions for indexing in Word or LaTeX) rather than editing 
the completed index to delete individual page numbers.
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Choice of heading

Main headings should typically be nouns (qualified or unqualified) rather than 
adjectives or verbs on their own,

e.g.:

agriculture, decline of

not

decline of agriculture

novels, Victorian

not

Victorian novels

How specific entries or sub-entries should be will depend on the subject of the 
book. 

In a book on nineteenth-century London, it would be unhelpful to have an entry 
under London because the entry would have to be so long and complicated that it 
would become unwieldy. It would be more practical to have entries on the topics 
about London which are discussed in the book, e.g., gardens, sanitation, streets, 
crime etc.

Synonyms

Where there are two or more possible synonyms, use the one the reader is most 

likely to look up and put all the relevant items in that entry. Under the synonym put 

a cross-reference: ‘see [main heading]’.

Be careful not to have too many cross-references – your reader will be able to work 

out where most things are likely to be indexed.

Treat similar items in a similar fashion. In a book that discusses countries, for 

example, be consistent:

France (main heading)

	 Industry (sub-heading)

Spain (main heading)

	 Industry (sub-heading) not Spanish industry (main heading)
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When to combine entries

If a word is used in both singular and plural forms in the text, only one form 

should be used in the index. This rule does not apply, of course, if the two forms 

have different meanings, e.g. damage, damages.

When a word has more than one meaning, there should be a separate entry for 

each meaning, with an explanatory phrase to show which meaning is intended.

Proper names which merely share the same first word should each have their own 

entry, e.g.:

Booth, John Wilkes (main heading)

Booth, William (main heading)

not 

Booth (main heading)

	 John Wilkes (sub-heading)

	 William (sub-heading)

Proper names

References to a peer should be collected under either the title or the family name, 
whichever is the more familiar to the reader; if both forms are used in the book, or 
the peerage is a recent one, provide a cross-reference from the other form.

This principle applies to any person or place known by more than one name.

Saints, kings and popes are indexed under their forenames, but places, institutions, 
acts of Parliament, book and play titles, etc. are placed under the first word after 
the article, e.g.:

William IV, king of England but King William Street

or

Lewis, John but John Lewis Partnership Ltd

No entry should begin with ‘a’ or ‘the’ except in an index of first lines, e.g.: 

Abortion Act, The

Importance of Being Earnest, The
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Compound personal names, whether hyphenated or not, should be indexed under 
the first element of the surname, e.g.:

Vaughan Williams, Ralph

In French, Italian and German names a preposition follows the forename(s), but an 
article or compound of preposition and article (La, Du, Des) precedes the surname. 
Names naturalised in Britain or the United States are usually indexed under the 
prefix:

Goethe, Johann Wolfgang von but De Quincey, Thomas

Page number style

Avoid ‘passim’ unless there are a large number of general references to a person or 
topic in one section of a book. If the reader could find these general references by 
looking at the Table of Contents, it may be unnecessary to index them as well.

Distinguish between a span (a continuous discussion of the topic) and a point (two 
separate mentions). 

Useful indexing resources:

•	 Chicago Manual of Style

•	 Pat Booth, Indexing: A Manual of Good Practice

•	 Nancy Mulvany, Indexing Books

•	 Beth Luey, Handbook for Academic Authors

5. Indexing in Word

If you are indexing before submitting your manuscript, you will need to compile 
one single Word document of the entire manuscript before you start. We cannot 
accept indexes done on individual chapters.

If you are indexing during the copy-editing of your book, you will be sent a 
formatted typescript to use for indexing.

NB: The formatted typescript sent to you is for indexing only, so please don’t make 
changes to the text in this file. They will be ignored by the typesetter.
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Before starting

Before starting work on your index, please review our content instructions, ‘Before 
You Start’, which explains the content and style of a good index. If there are issues 
with the quality or content of your index, you may be asked to amend it.

If you would like to have a sample of your index checked to ensure it fits our 
technical and content requirements, please get in touch with your Press contact.

Creating an index in Microsoft Word

Video Guide

A clear, step-by-step video guide to the indexing process can be found on YouTube 
here https://www.youtube.com/watch?v=s8lq84CLYvU&t=2s 

Using the Word Indexing tool is straightforward and comprises two basic 
procedures:

(a) identifying or tagging the index entries in the document, building the index as 
you go, and (b) inserting the collection of entries at the end of the document.

Getting started 

1.	 We advise reviewing the typescript and compiling a list of the terms to include 
in the index before you start making tags. This will help you decide how to 
structure your headings, subheadings and cross-references, and to avoid 
overlooking important terms. 

Please refer to the Content guidelines for help with this.

Remember that it is essential that long strings of page numbers (e.g. more than 
about 8-10 page references) under a main entry are divided up using sub-
entries.

This type of entry:

labour, 86

division of 86, 88, 91

elasticity of substitution with capital 25

flexible labour market 152
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Indexing a word or short phrase

1. To use a word or phrase as typed as an 
index entry, select the relevant text and 
hold down ALT+SHIFT+X.

2. To index text under a different heading 
(not under the word or phrase as typed 
in the text), place the cursor next to the 
text that you are indexing (i.e. without 
selecting any text) and hold down 
ALT+SHIFT+X. The following dialogue 
box will appear:

Here the word ‘indexing’ had been highlighted in the text before holding 
ALT+SHIFT+X and so appears automatically in the Main entry box.

3. Edit the text in the Main entry box if necessary (or type in your preferred 
heading).

NB: Do not use quotes around proper names (e.g. “Hawking, Stephen”) in your index 
entries as Word will place all entries enclosed in quotes at the start of the index 
instead of alphabetising them properly.

4. To create a subentry, type the headword in the Subentry box below the Main 
entry box.  Sub-sub-entries should be avoided but, if essential, type the 
subentry text followed by a colon (:) and then the text of the sub-sub-entry.

heterogeneous 184

labour-saving innovations 136

machinery replacing 143

productivity 15, 86

pure labour economy 129–30

reserve army 22, 76, 97, 99, 101, 122, 148

unlimited supplies 76

value and 87, 89, 96, 97, 102, 125, 126, 128, 129, 130

Is far more useful to a reader than:

labour, 15, 22, 25, 51, 68, 86, 87, 88, 89, 91, 97, 101, 102, 125, 126, 128, 129-130, 
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5. You can modify the font of a main entry 
or subentry by selecting it and then 
right-clicking to select options from 
the font menu (to add styling such as 
italics for example – note that the usual 
keyboard shortcuts also apply here).

6. The ‘Current page’ option (centre of the 
dialogue box) is the default: it simply 
inserts the page number into the index. 
If you want to create a cross-reference 
from the index entry rather than 
insert a page number, click the ‘Cross-
reference’ option and type the cross-
reference text into the box:

	 NB: Inserting a cross-reference entry 
does not include a page number 
reference at the same time. If you are 
including a ‘see also’ cross-reference, 
for example, you will have to mark an additional page entry to ensure that the 
page number also appears in the index.

7. Two checkboxes allow you to specify 
that the page number for this index 
entry should be bold or italic (check 
both boxes for bold italic)

8. To mark the index entry, click ‘Mark’. 
There is the option of marking all occurrences of the word, using ‘Mark All’, 
but this is not advised. 
NB: ‘Mark All’ should be used sparingly and only for very specific and 
infrequently occurring terms. If you use ‘Mark All’, every occurrence of the 
phrase you’ve selected will be indexed. This can often lead to long strings of page 
numbers, many of which will be irrelevant or unhelpful for the reader. If you use 
‘Mark All’ throughout, your index may be returned to you for revision.

	 Note that the Mark All option is available only if you selected text before 
opening the dialogue box – not if you typed your own text into the dialogue 
box.
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9. You can close the indexing dialogue box or leave it open while you work. If 
you leave it open, you can move around the document and select new words/
phrases to index. When you want to insert a new index entry, click on the 
dialogue box to reactivate it. Any words that you have selected when you click 
will appear in the Main entry field.

Indexing a whole section or ‘span’ of text 

The third option in the indexing dialogue box, along with ‘Cross-reference’ and 
‘Current page’, is ‘Page range’. This is the option that allows you to assign an index 
entry to continuous text (whether or not it runs over multiple pages). The process 
has one additional step to the process for indexing a word or phrase: you have to 
begin by giving Word a name for the section of text that you want to index. You do 
this by creating a bookmark in Word.

1.	 Select the range of text that you want to index. 

2.	 From the ‘Insert’ 
menu (or on the 
‘Insert’ ribbon in later 
versions of Word), 
select ‘Bookmark’. The 
following dialogue box 
will appear:

3.	 Type a one-word name 
for the bookmark 
(this could be the 
index headword you will be using, for 
example) in the top line and click ‘Add’ 
to save it.

4.	 Place your cursor at the end of the 
bookmarked section.

5.	 Press ALT+SHIFT+X to open the 
indexing dialogue box, and do 
everything as you would for a standard 
entry (see above), including typing the 
headword, except the colon.
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6.	 Click on the ‘Page range’ option and choose 
the name of the bookmark you’ve just 
created from the dropdown list immediately 
below.

NB: Each span of text must have a 
separate bookmark name, even if related 
to the same index entry, or there will be 
errors in the index.

Creating the index list 

It is advised that you review the index regularly 
as you work through the process.

To do so follow these steps:

1. Place your cursor at the end of the document before any endnotes inserted 
using Word’s automatic endnotes feature.

2. Choose ‘Index and Tables’ from the ‘Reference’ submenu of the ‘Insert’ menu in 
Word (or ‘Insert Index’ in the ‘References’ ribbon in Word 2007).

3. Click ‘OK’ in the dialogue box that appears. This creates an index in Word’s 
standard layout. There is no need to engage with the options for changing 
the format of this index (alignment, spacing, etc.) as this will be taken care of 
during typesetting.

Important notes on indexing in Word 

•	 Word automatically deletes duplicate page entries for the same heading.

•	 After you have created the index you can continue to work on it. To update 
the index to take account of changes, place the cursor anywhere within the 
index and press the F9 key.

•	 The order in which Word sorts index entries does not take into account the 
subtleties of alphabetisation that have become standard in publishing. 
NB: It is, therefore, important to note that any rearrangements you make to this 
list will automatically be undone when the list is refreshed.

•	 Make sure you review the index once generated for general consistency – for 
example, making sure singular and plural nouns, spelling and capitalization 
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are used consistently.

 
Editing the index list 

Should there be any changes that you want to make to the layout, order or content 
of the index but cannot achieve directly in the automatically generated list (for 
example, adding note numbers after page numbers), please copy the list to a new 
Word file and make the changes with ‘Track Changes’ switched on (see below). 
We’ll extract the index from the main Word file and incorporate your marked 
corrections during typesetting.

Once you have finished indexing, follow these steps to make edits to the list:

1. Generate the final index list following the steps outlined above.

2. Copy the list and paste it into a new Word file.

3. Switch on ‘track changes’ and make any text edits necessary to bring the list up 
to your expectations. 
NB: Changes should be made to the text parts of the index only. Changes should 
not be made to the page numbers, which are automatically generated. Any 
alterations to the page numbers will be lost.

4. Save the file (without accepting the changes) and send it to your Press contact 
along with the main ‘tagged’ Word file.

These corrections will be incorporated once your book is in production.

Modifying index entries after you’ve typed them 

Word holds index entries directly where they have been placed in the file, as 
hidden text. To view the entries, you have to unhide the text by clicking the ¶ 
symbol on the ‘Standard’ or ‘Home’ toolbar in Word. The index entries are in curly 
brackets, with the code XE at the beginning. A typical entry might look like this:

{XE “indexing:in Word:advantages of”}.

Here, ‘indexing’ is the main entry, ‘in Word’ is a subentry, and ‘advantages of’ is a 
sub-subentry. You can edit this text to change the index term.
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Deleting an index entry 

Select the entire index entry field, including the braces {}, and then press DELETE.

Creating two or more indexes in a single Word file

If you think your book requires more than one index, please discuss the issue with 
your Commissioning Editor. If they agree, you can create those indexes using the 
Word tool. This can be done by either:

•	 Creating two indexes in two separate Word files

•	 Create separate indexes within the same file. This is achieved by editing the XE 
tags Word uses to build the index, by inserting the \f switch into an XE tag as 
detailed below.

Switch method

•	 Choose a unique ‘switch’ for each of the indexes you want to create, for 
example, ‘general’ for a general index and ‘name’ for an index of names.

•	 Then, after you have clicked ‘Mark’ in the dialogue box, you need to add 
the appropriate switch before the closing curly brace of the XE tag which is 
embedded in the text.

The syntax looks like this:

\f “general”

•	 When you have inserted the index (see ‘Creating the index list’ above), right-
click on the index and select ‘Toggle field codes’. The following text will appear 
in place of the index: 
{ INDEX } 
(this will include some other coding as well; e.g. { INDEX\c”1”\z”205”}).

•	 Type in the switch for the particular index you want to appear immediately 
following the coding, e.g. /f “general” (the complete code will look something 
like this: { INDEX\c”1”\z”205\f “general”}).

•	 Right-click on the code and select ‘Toggle field codes’ again and the index will 
appear.

•	 Place the cursor at the end of the index and insert the index again. You’ll be 
asked if you want to replace the existing index, so select ‘no’. When the second 
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index is inserted you need to go through the Toggle field codes again, but 
this time entering the switch for the other index. The second index will then 
appear.

Creating an index in Word using a Mac 

Marking index entries for words or phrases 

1.	 Select the text that you want to use as an index entry.

2.	 On the ‘Insert’ menu, click ‘Index and Tables’.

3.	 Click the ‘Index’ tab, and then click ‘Mark Entry’. Tip: To go directly to the‘Mark 
Index Entry’ dialogue box, you can also hold COMMAND+ALT+SHIFT+X.

4.	 Type or edit the text in the Main entry box

Subentries 

•	 To create a subentry, specify the main index entry, and then type the subentry 
in the Subentry box.

•	 To create a sub-subentry (third-level entry), type the subentry text followed by 
a colon (:) and the text of the third-level entry.

•	 Tip: To mark index entries for symbols such as @, in the ‘Main entry’ box, 
immediately following the symbol, type ‘;#’ (semicolon followed by the 
number/hash sign), and click ‘Mark’. When you build the index, Word places 
the symbols at the beginning of the index.

•	 To mark additional index entries, select the text or click immediately after it, 
and click in the ‘Mark Index Entry’ dialogue box.

NB: Word inserts each marked index entry as an XE (Index Entry) field in hidden 
text format. If you don’t see the XE field, click ‘Show/Hide’ on the Standard toolbar. 

Indexing a whole section or ‘span’ of text

1.	 Select the range of text that you want the index entry to refer to.

2.	 On the ‘Insert’ menu, click ‘Bookmark’.

3.	 In the ‘Bookmark name’ box, type a name, and then click ‘Add’.

4.	 In the Word document, click at the beginning of the range of text selected.
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5.	 On the ‘Insert’ menu, click ‘Index and Tables’.

6.	 Click the ‘Index’ tab, and then click ‘Mark Entry’.

7.	 In the Main entry box, type the index entry for the marked text.

8.	 Under ‘Options’, click ‘Page range’.

9.	 In the Bookmark box, type or select the bookmark name typed in step 3.

10.	 Click ‘Mark’.

11.	 Click ‘Close’.

NB: Word inserts each marked index entry as an XE (Index Entry) field in hidden text 
format. If you don’t see the XE field, click ‘Show/Hide’ on the Standard toolbar.

Editing an index entry 

Edit the text inside the quotation marks, as shown below:

{XE “Callisto” \t “See Moons”}

Here, “Callisto” is the main entry and “See 
Moons” is a cross reference. You can edit this text 
to change the index term. 
If you don’t see the XE (Index Entry) fields, click ‘Show/Hide’ on the Standard 
toolbar. 

NB: If you modify the index entries in the finished index, Word deletes your 
changes the next time you rebuild the index. To permanently keep your formatting 
changes, format the index entry fields in the document. 

Deleting an index entry 

Select the entire index entry field, including the braces {}, and then press DELETE.

1 = Main entry 

2 = Cross reference 

If you don’t see the XE (Index Entry) fields, click ‘Show/Hide’ on the Standard 
toolbar. 

NB: If you modify the index entries in the finished index, Word deletes your 
changes the next time that you rebuild the index. To permanently keep your 
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6. Indexing in LaTeX 

For manuscripts submitted in LaTeX, we require a LaTeX index to be provided 
alongside your final completed manuscript.

We recommend using MakeIndex (available here  
https://ctan.org/pkg/makeindex?lang=en ) to produce your LaTeX index. 

Please refer to our style and content instructions before starting your index.

Make sure you review the index once generated for general consistency - for 
example, making sure singular and plural nouns, spelling and capitalization are 
used consistently.

If you have agreed with your Commissioning Editor that several indexes are 
necessary, there are some useful instructions here:  
http://www.tex.ac.uk/FAQ-multind.html

Indexing in LaTeX is well-supported by online guides, but if you need help, get in 
touch with your Press contact for assistance. 

formatting changes, format the index entry fields in the document.

Creating the index list 

After you create the index entries, you can build the index in your document. This 
should normally be placed at the end of the file.

Building an index using one of the supplied index designs 

1.	 Click in your document where you want to insert the finished index.

2.	 On the ‘Insert’ menu, click ‘Index and Tables’, and then click the ‘Index’ tab.

3.	 Click a design in the ‘Formats’ box.

4.	 Select any other index options that you want.
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8. Indexing During Production  

Although it is preferred, it is not always possible to create an index before 
submission. In these cases, you will need to provide an embedded index during the 
production process.

Your Content Manager or Project Manager will send you the indexing instructions 
and information about the deadline for providing your embedded index.

7. Commissioning a freelance indexer 

If you decide to commission an indexer yourself:

•	 The index must still fit the technical specifications set by the Press, in terms of 
the embedding method or software used, the length, deadline and the output 
(e.g. type of files) supplied to the Press. Indexes provided that do not meet our 
technical and content specifications may be rejected. If you are in any doubt, 
please check this with your Content Manager or Project Manager.

•	 Liaising with the indexer, arranging deadlines, payment, etc., is entirely the 
responsibility of the author.

•	 The Press cannot recommend specific indexers, but listings of indexers by 
subject specialism are available on sites like the UK Society of Indexers (UK) 
http://www.indexers.org.uk  and the American Society of Indexers (US) http://
www.asindexing.org/ 

If you’ve agreed with the Press that we will provide an index by a freelance 
indexer:

•	 Your Content Manager or Project Manager will commission an indexer who 
works on your subject area and they will create an index from your text, 
taking into account any briefing information you have provided.

•	 While we have a pool of experienced indexers covering our full range of 
subjects, the indexer will not have your level of expertise in the specific area 
covered by your book.

•	 You will be sent the index for checking, but there is limited scope to return 
the index to the indexer if the index provided is not what you expected unless 
there are substantial problems with structure or coverage. 
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•	 It may be helpful to create a list of headings/keywords for the index before you 
are asked to do this and, if you are editing a multi-contributor volume, you 
could solicit suggestions for keywords from contributors when they supply 
their finished chapter typescripts.

•	 You will receive from the typesetter a typescript which you must use to 
complete your index; please do not create your index on any other file, as we 
will not be able to use it.

•	 Do not try to make changes or corrections to the text on this typescript, as they 
will be ignored by the typesetter.

•	 To avoid delaying publication, you must complete your index by the specified 
deadline.

•	 During indexing, your Content Manager or Project Manager can offer 
assistance with technical questions and check a sample of your indexed 
document if you are unsure that you are proceeding correctly.

•	 You must follow the indexing instructions you are given. Do not try to 
improvise a system of your own as this can lead to technical problems, delays 
to publication and, frequently, significant duplication of effort on your part.

http://www.cambridge.org/gb/academic/authors/author-hub#fRRc9BkrdgAi3V4W.97
mailto:authorhub%40cambridge.org?subject=


http://www.cambridge.org/authorhub
mailto:authorhub@cambridge.org

